The COLONEL'S BEQUEST

TR
| PN
SRS
KA

ALYBABYBALL
AR RIS
KR L IHA

GRS
SIS

[ceri fram AmfgaAnzEnuzElsANEhsie

APlayb

y ROBERTA WILLIAMS




ABOUT THE COLONEL'S BEQUEST

The COLONEL’S BEQUEST is different from many
adventure games. It can best be described as an
interactive play in 8 acts. You will play the entire game
in one location, on an isolated island in a bayou. Events
can take place throughout that locale at any time during
the game, and they may occur whether you are present
or not.

At the end of each Act, a clock will appear on your
screen and strike the hour. It will also appear at other
intervals during the game. Take note of the events
which cause this to happen, and your location at the
time it occurs, as this will help you to keep track of your
progress. Being in the right place at the right time can
be invaluable.

Also, if you have thoroughly explored a room, don’t
assume that the next time you visit the room things will
be the same. While you are exploring another area,
someone else may enter the room and leave a valuable
clue for you to find!
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CAST OF CHARACTERS

Laura Bow

Laura is a 20 year old
gur alism major al

ulane Universit;
New Orlean: A 92
ingenue, she’s studi
and down to Cdl'lh
energetic and
courageous. She’s known
for her inquisitive nature,
gmbably acquired from

er father, a detective on
the New Orlcans Police
force.

Ethel Prune

Lilian's mother and the
Colonel
Ethel s Krtown Tor her
whimpery, whiny nature.
You can usually catcl

her in a rather tipsy state,
and she gives
impression of being
quite helpless.

ounger sister,

Colonel Henri Dijon

Henri Dijon is a gruff old
southern-style colonel.
He's wealthy, eccentric
and reclusive, He lives
alone except for his
servants; ie.
and Fift, and his peh “He
was wounded w

serving with Wetinction
in the Spanish-American

Gertrude Dijon

Gertie is the widow of the
Colonel’s younger
ie's known as

im a fondness for
jewelry. .. especially
pearls.

Lillian Prune

Lillian is Laura’s college
classmate and the
Colonel s nicce, Her
personality cai

Gescribed s extroverted
and rebellious. She
drinks, smokes and dates
several young men.
dresses In Ihe style of the
1920's

Gloria Swansong

Gertie’s daughter and the
olonels niece. An

aspiring actress, Gloria

enjo

Hdl@wwd;nre Siyle.
he’s a beautiful
Cen Do g
oves money, jewelry

and rich boyfriends.




Rudolph Dijon

Rudy is Gertrude’s son,
Gloria’s brother and the
Colonels nephew. He
Eevcs the impression of

ing 3 ltle too slick.
Rudy is known

gambler, a wnmanwcr

Snda lush, They say ie’s
never worked an honest
day in his life.

Jeeves

Jeeves is the Colonel's
tll, ilent butier, Very
imposing a

he s not lernbly fnendly
or helpful. What is h
really after?

Clarence Sparrow

Clarence is the Colonel's
attomey. He manages all
of the Colonel’s business
affairs and accounts. He
seems rather sneaky, and
hat he huots after
the Colonel’s money.

Eiffis the Colonels sexy
French maid. |
Tomoréd thal she and the
Colonel are involved in a
relationship of a
somewhat more than
domestic nature, Most of
ihe family arc of the
gpinion hat Filt i using

c Colonel to get at his
L3 ey.

Dr. Wilbur C. Feels

Dr. Feels is lhe Colonel‘s
long time pers.

physician, fio o Ernown
for his lecherous ways,
and his questionable’
‘medical practices.

Celie s the Colonel’s
cook. She is quue
superstitious and
somewhat reserved,  but
she can be trlendl
helpful if apy roache




Beauregard

Beauregard is the
Colonel's da% A lazg old
bloodhound, he can be
observed lying near his
doghouse most of the

Blaze Polly
Blaze is the Colonel's old ~ The Colonel's parrot sits
horse. Like the Colonel, on his perch in the parlor.
he's a veteran of the He talks when he’s in the
Spanish-American war, mood, or when properly
but now rarely leaves the motivated.

comfort of his stable.




ACTI
SCENE I

Scene: Day. Campus commons, Tulane
tudyg 1 & ! | University in New Orleans, Louisiana in the
year 1925, during a class break. LAURA
BOW sits upon a bench, center stage,
reading a textbook. LILLIAN PRUNE
stands near LAURA, also center stage.

LILLIAN: Laura, I ve just received an invitation to.visit my Uncle Henri's estate for a family
reunion this weekend.

LAURAE: (seemingly-absorbed in‘her studies) That sounds nice, Lil. You must be so-excited.

“LILLIAN: Yes, I suppose’l am. (looks slightly puzzled, then her face suddenly lights up)
Maybe you'd like to come along! Unclé Henri’s mansion is on a private island, right in the
middle.of the bayou. Someone like you should find it fascinating!

LAURA: I don’t kinow, Lillian. I really should study.
LILLIAN: Oh; come on Laura. Tt'll be fun!
(pause)

LAURA: (looking up anid closing fier book) Well; F'suppose it won't hurt. At any rate it should
be more fun than reviewing for my biplogy exam.

LILLIAN: Oh, we'ré going to have such a time. You won’t regret it, Laura!

SCENE II
Scene: Night. A dark and misty bayou .
LAURA and LILLIAN skim through the
gloom aboard a small skiff. A tall and
silent BLACK MAN pilots them. The
silence.is broken occasionally by the eerie
cry of a night bird. Finally the form of a
grand house becomes discernible through
the dense trees. The skiff comes to a halt
at a small-dock, and the girls disembark.
Without a word, the BLACK MAN turns
the boat around and is quickly l last in the
dark mists of the bayou. LAURA waiches
until she can no longer se¢ him: -




SCENE Il
Scene: An island in the swam,
unkempt grounds of Colonel Byun ’s estate.
An ominous looking, run down old mansion
is visible in the background. LAURA

ILLIAN are walking toward the idiies
LAURA looks around continuously, as i she
expects something to jump out o]
el DL LIAN spass,

LILLIAN: Well, what do you think, Laura?

LAURA: (clutches her chest, then seems to
caich her breath) It's not exactly what 1
expected (looks around), but it looks interesting, all right (shivers).

(Pause as the girls walk in silence for a moment.)

LILLIAN: Uncle Henri was a colonel in the Spanish-Ametican war, you know. In fact, he still
prefers to be called Colonel Dijon, I don’t call him that, though - to me he's my dear old
Uncle Henri.

(LILLIAN pauses, looks wistful, as though recalling fond memories.)

LILLIAN: He's a peculiar old bird, though. He covets his privacy and detests being bothered.
That’s why he bought this place (gestures about them). When L-was a little girl, he would
invite me t0 visit him here in the summers. Looking back, it seems that I was the only one in
the family that he really cared about. That I'm puzzled about this *family reunion’. I
never would have expected a family gathering at Uncle Henri’s.

SCENE 1V

Scene: The large front porch of the Dijon
mansion. LILLIAN aind LAURA stan

center stage before an immense door. On-the .
door are two huge door knockers.

LILLIAN: (reaches for one of the door
knockers, giggles) Kinda creepy, isn’t it?

(LILLIAN brings the door knocker down
with a loud BANG! and again BANG! A
short pause, then the door creaks open to
reveal JEEVES, the 1all gaunt butler.)

JEEVES: (in a deep, imposing voice) Yeees
(LAURA gapes at the formidable butler)
LILLIAN: (siniling) Jeeves, it's me, Lillian . ... don’t'you remember?

JEEVES: Ol yesss, Well, everyone clse has arrived and they’re assembling i the dining
room. Please come in-and join ther.



(JEEVES steps aside and gestures for the wo girls to enter. LAURA and LILLIAN proceed
into the house.

SCENE V

Scene: The dining room of the Dijon

mansion. A fire is ablaze in the fireplace,

upstage center. An enormous dining table,
fendidly set, occupies center siage.

Spllzd at lh! table are LAURA,

LIAN; ETHEL PRUNE, LILLIAN’S
mmhzr GERTRUDE DIJON, widow of
the COLONEL'’S late brother; GLORIA
SWANSONG, GERTRUDE’S daughter
and the COLONEL’S niece; RUDOLPH
DIJON, GERTRUDE’S son, GLORIA’S
brother and the COLONEL'S nephew;
CLARENCE SPARROW, the
s COLONEL'’S attorney; and DR, WILBUR
C. FEELS, the COLONEL’S long time personal physician. During dinner, LAURA is introduced
10 the other guests. They are largely unpleasant, and bicker amongst themselves throughout the
meal. At last, dessert is served.

(Enter COLONEL DIJON in a wheelchair. He is being aided by FIFL, his sexy blonde maid.
She parks him at the head of the long table.)

COLONEL DIJON: (nods fersely, and speaks in a griiff voice) I'm glad o see that you're all
here. I'm sure you're all.- wondering why I've asked you.

(pause; as DUON clears his throat)

COLONEL DIJON: Asyou know, I am a very wealthy man., Unfortunately, I beliéve my end
is near, and 50T have decided (0 bequeath my many miilions to each of you. ..

(pause, as DIJON appears 10 notice LAURA for the first time)
COLONEL DLJON: Who are you, dear?

LAURA: (nervously) Oh, T beg your pardon sir. my name is Laura Bow
Lillian's. Would you like me to leave the room while you talk about this

- I'm just a friend of

COLONEL DLJON: No, o, just it where you are, I'm nearly finished, Now where was 2
Oh, yos. AHEM! As [ was saying, each of you here, except for Miss . . . ah, Bow is it? Yes,
well you'Ilall inherit EQUALLY upon my demise. If any of you should expire before I do,
then your share will be divided equally among the surviving parties.

(paiise, as DION surveys his guests, apparently letting his words sink in. The guésts look at

one danother suspiciously

COLONEL DLJON: I'm tired. Fifi. Help me to my room (looks again at the assembled
guests). If you'll all excuse me, I'm going (o retire for the evening. I will see yourall in the
morning. Haye a pleasant night.

(DIJON signals FIFL, who turns hiim around and wheels him from the room. The group sits in
silence until DUON is gone.)



GERTRUDE: Can you belicve that?
RUDY: The old goat.

GLORIA: I'm surprised he didn’t try to take it with him, he’s such an old skinflint!
RUDY: I don’t think YOU deserve any money!

GLORIA: Speak for yourself!

CLARENCE: How much do you think he’s got?

WILBUR: Well, I know what I'm going o do with MY share!

CLARENCE: YOUR SHARE?! T bet the old codger outlives YOU!
GERTRUDE: I wonder how sick he is?

ETHEL: Do you think he’Hl go soon?

LILLIAN: (standing abruptly) I've had enough of this! Laura and [ will retire to our room
now.

(exit LAURA and LILLIAN)

SCENE VI
Scene: Guest room shared by LILLIAN
and LAURA. Two beds occupy upstage
right and downstage right. A small couch
sits down'stage center and near it, an
armchair. A large portrait of COLONEL
DIJON hangs upon the wall above the
[fireplace, upstage center. LILLIAN opens
‘her suitcase and rummages through it.

IRA surveys the room.

LILLIAN: Will you excuse me, Laura?
I'm going to freshen up a bit. Please

make yourself at home and feel free (o explore!

LAURA: Thank you Lil, I may do just that.

(LILLIAN flounces out of the oo, léaving Laura alone. LAURA wanders arotind the room
for a short time, examining closets, drawers and various objects, then ventures out into the
enormous mansion.y

. ON.-WITH THE SHOW ... ;L o
As usual, Laura’s curiosity has gotten the better of her. In this case however, I'm
afraid she may be in a little over her head. Let’s join her now, before the real fun
begins. Maybe we’ll be in time to be of some assi to her as she to
solve the mystery of.... THE COLONEL’S BEQUEST!
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HOW TO READ THIS MANUAL

Throughout this manual we will be using the following ways of representing information:

MENU COMMANDS will be capitalized.
Example: SAVE, RESTORE, QUIT, PAUSE

Typed commands will appear as bold type.
Example: ‘type: ask lillian about ethel’
‘type: cd \sierra’

Portions of the command line not meant to be typed will not appear in bold type. For
example, in the line ‘type: cd \sierra’, ‘type:’ should not be typed.

[Example text] and [Keystrokes] will appear in brackets setting them off from the
surrounding text. The brackets ([]) are not keystrokes and should not be typed.
Example: [object], [character], [Spacebar], [Tab], [PageUp]

Two or more keys that should be pressed at the same time will be separated by a hyphen
(). This hyphen is not a keystroke, and should not be typed.
Example: *Press [Ctrl-1] to view your inventory.”

If a space appears between parts of a command, it is meant to be typed.

Example: ‘ly‘fe cd \sierra’ (the space between cd and \sierra should be typed as part of
the command.

The term ‘diskette” is used to refer to either 5.25" or 3.5" data storage disks.

ALL SYSTEMS
PLEASE NOTE: It is important that you view the README file on your game disk as it
may contain important information and instructions that were not available at the time
the documentation and other materials for this game were printed. Failure to review the
README file before installing the program may result in unexpected consequences
during the installation and/or running of the program.

MS-DOS README INSTRUCTIONS
To view the README file from DOS, type: readme. If the file is longer than one screen, Use
[Page Up}/[Page Down] to scroll through the file one screen at a time.

ATARI ST README INSTRUCTIONS

To view the README file from the desktop, double-click on the README.DOC icon. You
will see a message box with choices for SHOW, PRINT, and CANCEL. Choose SHOW to



view the file one screen at a time. Press [ENTER] to see the next screen. Choose PRINT to
print the file. Choose CANCEL to escape the message box.

AMIGA README INSTRUCTIONS
Insert WorkBench disk into drive DF0: and turn on your system. Double-click on the CLI icon.

Users with one drive: Copy the ‘type’ command into your RAM disk. See your Amiga
owner’s manual for instructions. Insert game disk 1. Type: type readme.

Users with more than one drive: Insert WorkBench in drive DF0:. Insert game disk 1 in
drive DFL:. Type cd DF1:. Type: type readme.

GETTING STARTED: DISKETTE DRIVES

It is always advisable to make back-up copies of your master program diskettes to increase the
life of the masters and guard against accidents. Follow your computer’s instructions to make
copies of all game diskettes.

Even if you will be playing from a hard disk, you may also want to format a blank disk for
saving games. Follow your computer’s instructions to format a blank diskette and keep it
handy for saving your game as you play. For some helpful tips on saving games, see the
“Saving Your Game’ (Page 9) and ‘Interacting with The Colonel's Bequest’ (Page 9) sections
of this manual.

When installing your program, you may be prompled to insert a ‘Drivers” disk. If you receive
this prompt, please examine your disks and insert the disk marked ‘Drivers’ and press
[ENTERY, so that the appropriate drivers will be loaded. Some games do not include a separatc
“Drivers’ disk.

MS-DOS

INSTALL THE GAME

Place the back-up copy you have made of disk 1 into your diskette drive. Type the letter of the
drive you have placed the diskette into followed by a colon (for example: a:), and press
[ENTERY]. Type: install and press [ENTER].

Answer the onscreen questions using the up and down [Arrow] keys to highlight your
selections, then press [ENTER] to select. You will be asked if you wish to install the game on
your hard disk. If you do nof wish the game to be installed on your hard disk, press [ESC] to
Skip this step. If you want to install the game on your hard disk, enter the letter designation of
your hard disk (usually C) and follow the prompts.

Please note: Even if you install to a hard disk, the install procedure will write a file
named RESOURCE.CFG to disk 1. For the installation to be completed correctly, DISK
1 MUST NOT BE WRITE PROTECTED. No other files on disk 1 are written or changed
by the install command.

o



LOADING INSTRUCTIONS
After completing the INSTALL procedure:

From diskettes:
1. Place Disk 1 into the A drive.

2. Type: a: and press [ENTER].
3. Type: sierraand press [ENTER].

From hard disk:
1. From your root directory, type: cd \sierra and press [ENTER]

2. Type: cb and press [ENTER].

SAVING GAMES TO DISKETTES
PLEASE NOTE: If you’re playing from diskettes, you must have a separate formatted
diskette ready before you can save a game. Since each diskette can only hold a limited
number of games, we recommend that you have more than one formatted in order to
assure adequate space for save game storage.
1.Choose SAVE GAME from the File menu,or press the [F5] key. The Save Game menu
will appear.

2.Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to
clear the command line.

3. Type the letter of the drive you are using for saved games, followed by a colon
(Example: a:) and press [ENTER].

4. Type the name of your saved game and press [ENTER| to complete the SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the
saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK

If you choose to save games to the hard disk, the program will automatically try to save to the
game’s own directory. If you run out of space for saving games, try one of the following
alternatives:

1. Save additional games to a diskette.

2. Save games to a different directory by using your [Tab] key to choose CHANGE
DIRECTORY from the Save Game menu (inside the game).




3. Delete the saved games and the save game directory from your hard disk by following
DOS instructions (outside the game). The program will create a new directory for your
games.

4. Create a new hard disk directory from DOS, using DOS instructions.

ATARI ST

LOADING INSTRUCTIONS

Note: If you are using an Atari 520 ST without memory expansion, turn off all desk

accessories (rename .ACC extension .ACX) before running your Sierra game.

1. 1f you are playing the game from diskettes: place Disk 1 in drive A, open the disk by
double-clicking on its icon. Start the game by double-clicking on SIERRA.PRG.

2.1f you are playing the game from a hard disk: open the disk by double-clicking on its
icon, then open the game folder by double-clicking on the game folder icon. Start the
game by double-clicking on SIERRA.PRG.

HARD DISK INSTALLATION

Please note: More than 512K of memory is needed to run Sierra games on your Atari ST hard

disk.

1. Open the hard disk by double-clicking on its icon.

2. Create a game folder by choosing NEW FOLDER... from the File menu. Open the
new folder by double-clicking on its icon.

3. Place Disk 1 in drive A:.

4. Copy the game disk into the new game folder by dragging the drive A: icon into the
window you opened in Step 3.

5. Repeat steps 3 and 4 for each of the other game disks.

6. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)

Your Sierra game is initially set up to play music and sounds through the Atari ST's internal
speaker. If you have one of the supported MIDI synthesizers. you may run the MUSIC
program to have the game play music through the synthesizer.

1. Open the game disk/folder by double-clicking on its icon.

2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.



3. Select MUSIC DEVICE from the Options menu.

4. Select your synthesizer (or ATARI ST INTERNAL SOUND) by clicking on the
appropriate button, and click on OK.

5. Select INSTALL GAME from the File menu. This will replace the RESOURCE.CFG
file on your disk.

Please note: It is important to turn on your synthesizer before starting the game.

AMIGA
STALLING THE GAME

NOTE: RENAME your copies of all game disks to remove the words ‘COPY OF’ from
the disk name. If the words ‘COPY OF" are not removed from the disk names of ALL the
copies, the system will continue to ask for the original disk, and will not run the game.

1. Boot your system with WorkBench, and insert Disk 1 of your Sierra game.
2. double-click on the disk icon, then double-click on the INSTALL icon.

3. Follow the onscreen prompts, choosing your selection with the mouse by clicking
once on the item.

4. You will be asked if you wish to install the game on your hard disk. If you do not wish
the game o be installed on your hard disk, select NO. If you want to install the game on
your hard disk, select YES.

5. Using your mouse, select which hard drive you wish to install the game onto.

6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS

From Floppy Diskettes:

1. If you have less than 1 megabyte of memory for your Amiga, turn your system off and
disconnect any external drives.

2. Insert Disk 1 into drive DF0:

3. Turn on your system.

From Hard Disk:

1. Load WorkBench and double-click on your hard disk icon.



2. Double-click on the SIERRA GAMES drawer.
3. Click on the drawer for the desired Sierra game.

4. Click on the game icon.

ALL SYSTEMS

PLAYING THE GAME

MOVING YOUR CHARACTER

You may move your character on the screen with the [Arrow] keys, the numeric keypad, or the
mouse. To halt your character’s steps with the keypad, press the number 5, or press the last
used direction key again. Do not attempt to move the character by holding down the
direction key. This will cause the character to start and stop continuously, resulting in
very slow progress.

Using the mouse, position the arrow to where you want the character to move, then click the
left mouse button.

stop

GAME SPEED CONTROL

At times it may be useful to slow down the speed of the game animation in order to negotiate a
tricky section, or observe something more carefully. In The Colonel's Bequest, speed is
controlled by the [+] and [-] keys, or by selecting a choice from the Speed menu, using the
mouse or [Arrow] keys.

MENUS

The Menu Bar in The Colonel’s Bequest is not visible during play. When you press [ESC], the
Menu Bar will appear at the top of your screen with several menus which can be opened to
show the command choices available to you.

KEYS TO USE IN THE MENUS

Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys to
highlight items within a menu. Press [ENTER] to select a highlighted command. Press [ESC]
10 return to the game without choosing a command.



SHORT CUTS FOR COMMON COMMANDS

You can use function and control keys to short cut many common commands.

[F1] Help

[F2] Toggle sound on/off

[F3], [Spacebar] Repeat previous command
[F5] Save Game

[F7] Restore (saved) Game

[F9] Restart Game (from beginning)
[Tab] Inventory

[ESC] Show Menu Bar, Pause Game
[CtrI-C] Cancel typed command line
[Ctri-D] Inventory

[Ctrl-P| Pause Game

[Ctrl-Q] Quit Game

[+ Increase Speed

[-] Decrease Speed

[=] Normal Speed

[Ctrl-V] Change Volume
[Shift-Click] Look at an object (see below)

SHIFT-CLICK

SHIFT-CLICK is a feature which will allow you to look at a person, place or object using your
mouse. Place the mouse arrow on the desired person, place or object, then hold down the
[Shift] key and press the mouse button. You will now receive a descriptive message.

* Please note: Multi-button mouse users should use the RIGHT mouse button and need not
press [Shift].

USING YOUR TAB KEY

While playing Sierra games, your [Tab] key will perform two major functions. You will use it
to review the items in your inventory, and also (if you're not using a mouse) to select options
from certain menus. The following menus will require the use of the [Tab] key for highlighting
‘menu optios

MENU _ CHOOSEFROM
1. Opening Yes, No

2. Restart Game Restart, Continue



3. Quit Game Quit, Continue

4. Save Game Save, Change Directory Cancel, Replace
5. Restore Game Restore, Cancel, Change Directory
6. Death Window Restore, Restart, Quit

USING THE MOUSE (optional)

Your mouse will be useful to you in moving your character, and in learning about your
surroundings. To move your character using the mouse, position the arrow to where you want
the character to move, then click the mouse button. If your mouse has more than one’button,
use the left button.

EXAMPLES OF COMMON COMMANDS

Many characters in the game will have information of one kind or another for you. To talk
with a character, type: talk to [character], ask (or tell) [character] about [character or object].
For example: talk to gertie, tell the colonel about lillian or ask lillian about the [object]. Try
different approaches. ‘Show’ an object to someone, and they may give you valuable
information. *Asking’ a character about something may evoke a different response than
“telling’ them.

You may encounter objects you need along the way. To take an object, type: take (or get) the
lobject] for example: take the note, or get the key.

Pay close attention to details. To look closely at objects, type look at the [object], for example:
look at the table. You can also use the [Shift-Click] feature described on Page 7.

You will need to use the objects you acquire as you explore. You can try different things such
as typing: use the [object], or give the [object] to [character] or show [object] to [character].
Different approaches to a puzzle may bring about a different outcome.

RETYPING COMMANDS
If you wish to repeat a command, select RETYPE from the Action menu or press the
[Spacebar] or [F3].

INVENTORY

If you wish to sce the items you are carrying, sclect INVENTORY from the Action menu, or
press [Ctrl-T] or [Tab]. A list of the items you are carrying will be displayed. To view an
object, click on its name with the mouse, or use the [Arrow] keys to highlight the name and
press [ENTER]. Press [ENTER] again, sclect OK or press [ESC] to resume play.

PAUSING YOUR GAME
If you wish to pause the game, select PAUSE from the Action menu, or press [Ctrl-P] or
[ESC]. Press [ESC] or [ENTER] to resume play.



SAVING YOUR GAME

If you wish to save your game, select SAVE from the File menu or press [FS]. To allow for
errors in ji and creative ion, we that you frequently save your
game in progress, and that you save several different games from different points as you play.
You will always want to save your game before encountering potentially dangerous situations.
You should also save your game after you have made significant progress.

PLEASE NOTE: If you’re playing from floppy disks, you must have a separate
formatted disk ready before you can save a game. We also recommend that you create
several directories or folders on your save game disk in order to assure adequate space
for save game storage.

If you choose to save games to your hard disk, we suggest that you create one or more save
game directories or folders on your hard disk. See your computer’s instructions for creating
directories or folders.

You may name your saved games using standard English phrases. For example, if you are
standing on a sandy beach, you might call your game standing on a sandy beach, or simply
beach.

RESTORING YOUR GAME

Select RESTORE from the File menu, or press [F7]. You will be prompted to select the game
you wish to restore. (On a single drive system, you will be prompted to insert your save game
disk). Highlight the desired game and select RESTORE. If the game you wish (o restore is in a
different directory, select CHANGE DIRECTORY.

QUITTING YOUR GAME
If you wish to stop playing, select QUIT from the File menu, or press [Ctrl-Q].

RESTARTING YOUR GAME
If you wish to restart your game at any time during play, select RESTART from the file menu,
or press the [F9] key. The game will begin again in the guest room shared by Lillian and Laura.

INTERACTING WITH THE COLONEL’S BEQUEST

You can generally interact with the game by typing simple commands consisting of as little as
anoun and a verb. For instance, the command get into the car can be shortened to get in car.
Unless otherwise instructed, follow all commands with [ENTER].

The Colonel’s Bequest will understand many common verbs. Here are some you might try:

LOOK CLIMB OPEN STAND
GET PUSH CLOSE GIVE
READ PLAY PULL EXAMINE
LOAD TELL SHOOT JUMP
TALK USE MOVE TAKE
PRY ASK SHOW



A message window will appear each time you enter a command, and at other times during the
game. When you have read the message, press [ENTER] to remove the window and resume
play.

TAKE NOTES as you discover clues and information. Record anything you think might be
important. Make a note of each area you visit, and include information about objects found
there, and dangerous areas nearby.

DRAW A MAP as you progress through the game. If you miss an area, you may miss an
important clue!

WATCH THE CLOCK. As you progress through the game, a clock will periodically appear
on your screen. Take note of the event and location when this occurs. This will help you to
keep track of your progress.

LOOK EVERYWHERE. When you enter a room for the first time, you will receive a
message on your screen describing the room. When you visit the room again you will need to
type: look around or look room to get the description. Look closely at all objects you
encounter.

EXPLORE cach area of the game very carefully, and be on the lookout for clues and hidden
places. Search every arca of the mansion and the grounds surrounding it. Re-visit an area
frequently, and make note of anything that has changed. Something may occur in an area while
you are clsewhere.

TALK to everyone you meet, but use discretion! Some characters will be friendly and helpful;
they may give you valuable information and advice. Others may mislead you. Try various
approaches in dealing with others. If talking to them or asking them questions yields few or no
results, show them something interesting you have found. They may have a comment that will
help you.

LISTEN closely o conversations. Useful information will pass between the other characters,
and you’ll want to pay attention to details that may help you with your investigation.

PICK UP anything that isn't nailed down. You will come across a number of objects that may
be of use to you later. You can see an inventory of items on hand by pressing the [TAB] key at
any time.

USE the items you have picked up to solve problems in the game, or to help you to make
progress and discover more clues.

BE CAREFUL, and remain alert at all times - disaster may strike in the most unlikely of

places.

SAVE YOUR GAME OFTEN, especially when you are about to try something new or

potentially dangerous. This way, if the worst should happen, you won’t have to start all over
10



again from the beginning. It is probably best to save at least one game in each act of The
Colonel's Bequest, 5o you will be able (o return to a desired point in the game. In effect, this
will enable you to travel backward through time and do things differently if you wish. After
you have restored a saved game, take note of the time of night. Refer to your notes; you will
need to repeat some actions to insure that other events will take place as they should.

DON'T GET DISCOURAGED. If you come to an obstacle that seems insurmountable, don’t
despair. Spend some time exploring another area, and come back later. Every problem in the
game has at least one solution, and some have more than one. Sometimes solving a problem
one way will make it harder to solve the next, and sometimes it will make it easier. If you get
stuck, you might try restoring a saved game from an earlier point, then choosing a different
path. If all else fails, you can buy The Colonel's Bequest hint book from the dealer who sold
you the game, or you can order directly from Sierra On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP. You might find it helpful (and fun) to play the game with a
triend. Two (or more) heads are better than one at interpreting clues and solving problems.

NEED A HINT?

If you find yourself “a little stuck’ while playing a Sierra game, try the following ideas:

1. 1f you have a modem, you can talk (o the Sierra Bulletin Board through the following

number:

(209) 683-4463
Our settings are 300, 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop will be
happy to help you.

2. Many other bulletin boards also provide hints to many of our games.
A. Compuserve: Go into the Gamers Forum (GO GAMERS) or write E-Mail to
76004,2143.
B. Prodigy: Write E-Mail to ‘HTWS90E’, or go to the PC Club and enter the
adventure games forum (Jumpword: PC CLUB).
C. PCLink: Select PCLink Plus, enter Publisher’s Connection, select Publishers
Forums, then Sierra On-Line. E-Mail may be written to the User ID ‘Sierra On Li’.
D. AppleLink: Select the KEYWORD option from the ‘Goto’ menu, and type:
Sierra. E-Mail may also be written to the User ID *Sierras’.
E. GEnie: From the main menu select 10 (Games), then select 1 (Games Round
Table). Select | (Games Bulletin Board), and type set 22 at the *?* prompt. This
will take you into the Sierra On-Line area.
For more information on these BBS lines, you can call these toll-free numbers:
1. Compuserve (800) 848-8199
2. Prodigy (800) 822-6922

3. PCLink (800) 458-8532



4. AppleLink (800) 227-6364

5. GEnie (800) 638-9636
For more information on the Sierra BBS, call:(209) 683-8989

3. The magazine Questbuster’s Journal is a helpful source of many game hints.

4. Your local software dealer may carry our hint books, or may be willing to order them
for you.

5.1f you are unable to obtain a hint book through a dealer, you can order one directly
from us. Call (800) 326-6634 to place your order with a Visa, MasterCard or American
Express card, or write Sierra On-Line Inc., Order Department, P.O. Box 485,
Coarsegold, CA 93614.

6.1 the hint book is not yet available for the game you are playing, call our automated
hint line at (900) 370-KLUE to receive a hint. NOTE: California residents, please dial
(900)370-5113.

THIS SERVICE IS AVAILABLE 24 HOURS A DAY. THE CHARGES ARE: 75
CENTS FOR THE FIRST MINUTE AND 50 CENTS FOR EACH ADDITIONAL
MINUTE. IF YOU ARE UNDER 18 YEARS OF AGE, YOU MUST HAVE A
PARENTS PERMISSION TO CALL . THE CONTENTS OF ALL MESSAGES
ARE SOLELY THE RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL
NOT BE GIVEN ON OTHER SIERRA TELEPHONE LINES.

WALKTHROUGH
Please note: In order to understand the object of The Colonel’s Bequest, it is very important
that you view the opening cartoon at least once.
HOW TO USE THE WALKTHROUGH. Onscreen movement: north = up; south = down;
west = left; east = right. The walkthrough takes you through several game screens. Move your
character around the screens to the suggested places, and type in the words that appear in bold
type.
WARNING: The following i ion is for beginning only. The contents
include answers to some game puzzles and hints that experienced adventurers may not wish to
see. Continue reading only if you are having difficulty getting started with The Colonel’s
Bequest.

As the opening cartoon ends, we find Laura and Lillian in their shared guest room. When
Lillian excuses herself and exits the room, you will have control of the game. The most
important thing to do at this point is to examine your surroundings.

Walk north to the fireplace. Notice the portrait of the Colonel above the mantle.
Type: look at the portrait [ENTER]



C) Press [ENTER]

D) Respond to DOS prompts.

Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a files=20
statement. Follow these instructions to create this file:

A) Type: a:[ENTER]
B) Type: copy con config.sys[ENTER]
C) Type: files=20[ENTER]

D) Press [F6][ENTER]

You should see the message: *1 File(s) copied”. You will now have to re-boot your computer
it your new Sierra Boot isk nthe deve. Tuen your computer offthen on, ot press
‘tri-Alt-] .

If this does not clear the above messages, call (209) 683-8989 for technical help. Our technical
staff will be happy to help you.

TECHNICAL HELP (ALL SYSTEMS)

Technical assistance is only a telephone call away. Call (209) 683-8989 for convenient,
person-to-person service, or if you prefer, you may request assistance by mail. If you choose to
write 1o us with your request, please state your computer type and the nature of your problem.

If you find that you need to send for replacement diskettes, send the original disk 1 in the size
you need (3.5" or 5.25") to:

Sierra On-Line

P.O. Box 485
Coarsegold, CA 93614
Attention: RETURNS
l}}eﬁ e to include a note stating your computer type, and the size of diskette you need (5.25" or

We will gladly replace your program free of charge for the first 90 days of ownership
(gleas_e enclose a copy of your dated sales receipt witgarour requcstg. After 90 days
there is a $5.00 charge for 5.25" diskettes, and a $10.00 charge for 3.5" diskettes.
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